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1 SEQUENTIAL FEATURES 

1.1 FULL-FIELD ABERRATION ANALYSIS (PROFESSIONAL AND PREMIUM EDITIONS) 
Improve your freeform designs by analyzing how various aberrations degrade the image or beam 
quality of your system across the full field of view. 

Freeform optical surfaces are a key element in many modern optical systems, used for example in virtual 
and augmented reality designs1. This new analysis feature displays aberrations and contributions to image 
degradation across the full XY field of view. You can now analyze freeform systems, in the same way you 
would do with any other regular sequential system, identifying the change in aberrations across the field 
of view and getting an indication of how to correct these. 

Figure 1.1.a. Positive and negative primary coma shown in False Color (left), icons showing absolute 
aberration as well as orientation (right). 

The Full-Field Aberration analysis displays Zernike coefficients at sampled point across the field of view 
(see Figure 1.1.a). You can also compute the average of each Zernike term across all sampling points. 

For displaying the data, you can choose between Icons and several color options including False Color. 
Icons allow displaying both the aberration magnitude in absolute values and orientation (see Figure 1.1.b). 
The color display options can show negative magnitude values, but do not show the aberration 
orientation. 

                                                            
1 Elliott, Norton, and Humphreys (2018). Optical design challenges in virtual and augmented reality. Laser Focus 
World.  

http://digital.laserfocusworld.com/laserfocusworld/201804/MobilePagedArticle.action?articleId=1373373#articleId1373373


Copyright © Zemax, LLC 2018. All Rights Reserved. Rev 2, 05/10/2018 4/17 

    

Figure 1.1.b. Icons showing Primary Astigmatism. 

The Full-Field Aberration analysis is located on the Analyze tab, in the Image Quality section. It can be 
found either in the Aberrations menu or in the Wavefront menu (see Figure 1.1.c). It can also be accessed 
from the PAL/Freeform menu in the Applications section of the Analyze tab. 

     

Figure 1.1.c. Access the Full-Field Aberration analysis from the Aberrations menu (left) or the Wavefront 
menu in the Analyze tab (right). 

The Full-Field Aberration analysis currently does not support fields defined in Theodolite angles. If you 
want to use the analysis, please convert the field type using the Convert To drop-down menu in the Field 
Type section of the Field Data Editor. 

Please send us your feedback about the new Full-Field Aberration capability using the Send Feedback 
button (see Figure 1.1.d). 
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Figure 1.1.d. Icons showing Primary Astigmatism. The Send Feedback button in the toolbar of the Full-Field 
Aberration analysis 

 

1.2 GRIN SURFACE USAGE WITH USER-DEFINED AND GRID SAG SURFACES (ALL 

EDITIONS) 
Design a wider range of optical systems when using gradient index surfaces. 

Grid Sag and User-Defined surfaces enable complete customization of sequential surfaces, which makes it 
possible to define arbitrary optical systems. It is now possible to combine these with gradient index 
(GRIN) surfaces. This means that you can have arbitrary surfaces with a varying index of refraction, which 
opens up a wide range of possibilities. 

 
Figure 1.2.a. A Gradient 9 surface followed by a User-Defined Surface. 

The ray trace through a GRIN media requires iteration to determine the point of intersection of the ray 
with the surface following the GRIN surface. Because of this, not all surface types are allowed to follow 
GRIN surface types. In OpticStudio 18.4, GRIN surfaces can now also be followed by User-Defined and 
Grid Sag surfaces (see Figure 1.2.a). 

1.3 TEST A NEW FEATURE EXPERIMENT (ALL EDITIONS) 
Get a sneak peak of what’s coming and help us refine a new feature. 

The Zemax Lab includes a new feature experiment. This feature is likely to change before final 
implementation and is not yet documented in the Help Files.  

The Grid Optimization feature adds local control to the sequential Grid Sag surface so that specific 
sections the surface can be optimized independently. With this local control, you will be able to improve 
the performance of your optical designs and create freeform sag surfaces without high order polynomials. 
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Figure 1.3.a. Setting up a Grid Sag surface for Grid Optimization. 

The settings for the Grid Optimization feature can be found in the surface properties of a Grid Sag surface 
(see Figure 1.3.a). After defining the region of interest, the Grid Sag points are added as variables for local 
and global optimization. Once the system is optimized, you can open the Grid Optimization dialog again 
to compare the table values between original and current sag. 

To turn on Grid Optimization, tick the checkbox that is located in the Feature Experiments menu on the 
Help tab, in the Zemax Lab section (see Figure 1.3.b). 

  

Figure 1.3.b. The Activate Grid Optimization checkbox in the Feature Experiments menu on the Help tab. 

Please send us your feedback about this feature to support@zemax.com or using the Send Feedback 
button. We’d like to know more about the types of systems you’re designing with this capability, and what 
functionality you would like us to add.  

2 NON-SEQUENTIAL FEATURES 

2.1 BOOLEAN NATIVE OBJECT (PROFESSIONAL AND PREMIUM EDITIONS) 
Run faster, more accurate, and more reliable ray traces with Boolean combinations of non-
sequential objects. 

This new non-sequential object supports a significantly improved ray tracing algorithm resulting in 
simulations being up to 10x faster than before. This enables you to make informed design decisions and 
evaluate virtual prototype iterations as quickly as possible. 

mailto:support@zemax.com
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The Boolean Native object is a new non-sequential object that uses a faster and more accurate ray tracing 
algorithm than the previously available Boolean object, which is now called the Boolean CAD object. For 
Boolean Native objects, the ray tracing algorithm utilizes the high precision surface definitions of the 
native parent objects, instead of converting them to a NURBS representation. For this reason, ray tracing 
with the Boolean Native object is typically much faster (up to 10x) and more accurate than the Boolean 
CAD object. 

 

Figure 2.1.a. Creating a Boolean Native object. 

With the Boolean Native object you can perform Boolean operations on volumetric non-sequential 
objects that are native to OpticStudio. The Boolean operations include adding objects together, 
subtracting one object from another, or defining an object as the intersection volume of two objects (see 
Figure 2.1.a). The resulting trimmed object can have properties assigned to each face independently. 

For more information about how to increase ray tracing efficiency in non-sequential simulations, read this 
Knowledgebase article. 

2.2 COMPOUND LENS OBJECT (PROFESSIONAL AND PREMIUM EDITIONS) 
Simulate complex lenses in non-sequential mode for stray light analysis or optomechanical design. 

The Compound Lens object is a new non-sequential object that supports complex combinations of 
surfaces and apertures on the front and back faces of a lens. A wide variety of custom lenses can now be 
simulated with the Compound Lens object in non-sequential mode for stray light analysis or 
optomechanical design. 

The Compound Lens object references two parent surface objects (see Figure 2.2.a). The supported parent 
surface objects include: Standard Surface, Aspheric Surface, Toroidal Surface, Toroidal Odd Asphere, 
Zernike Surface, Biconic Surface, Biconic Zernike Surface, Extended Polynomial Surface, and Grid Sag 
Surface. Additional surfaces may be added upon request.  

 

http://customers.zemax.com/os/resources/learn/knowledgebase/improving-nsc-simulation-speeds-with-nested-object
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Figure 2.2.a. A Compound Lens with a rectangular aperture creates a volume made from two non-sequential 
surface objects. 

Further information on how to create complex non-sequential parts using the new Compound Lens and 
Boolean Native objects can be found in this Knowledgebase article. 

2.3 UPDATES TO THE CONVERT TO NSC GROUP TOOL (PROFESSIONAL AND 

PREMIUM EDITIONS) 
Automatically convert off-axis systems with decentered apertures. 

Tracing sequential and non-sequential rays through the same optical system is crucial for designing virtual 
prototypes of optical products. This ensures manufacturability, which is a critical aspect of designing a 
high confidence virtual prototype. 

Optical systems using off axis lenses, mirrors with finite substrates, surfaces with decentered apertures, 
and more complex aspheric surfaces can now be automatically converted to a non-sequential system for 
further optomechanical design or stray light analysis. This is done using the Compound Lens and Boolean 
Native objects (see Figure 2.3.a). More information on how the Convert to NSC Group tool works can be 
found in the OpticStudio Help Files (The File Tab > Convert Group > Convert to NSC Group). 

 

Figure 2.3.a. An Off-Axis Parabolic mirror automatically converted using the Convert to NSC Group tool. 

The Convert to NSC Group tool is located in the Convert section on the File tab in sequential mode (see 
Figure 2.3.b). 

http://customers.zemax.com/os/resources/learn/knowledgebase/how-to-use-the-boolean-object-and-the-combine-obje
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Figure 2.3.b. The File tab with the Convert to NSC Group tool. 

2.4 CONE.DLL FOR SOURCE DLL OBJECT (PROFESSIONAL AND PREMIUM EDITIONS) 
Efficiently and accurately trace non-sequential rays to small or distant regions of interest. 

In systems with small or far-off detectors, a lot of rays have to be traced to get adequate statistics on 
those detectors, which makes modeling such systems very time-consuming. The Cone.DLL for the Source 
DLL object enables tracing source rays of either a uniform or Lambertian distribution of rays to small 
regions far off the source’s normal axis.  

This DLL is similar to the Lambertian_Overfill.DLL for the Source DLL object, and supports uniform and 
Lambertian angular distributions of the source rays. In addition, the region over which that rays are 
launched is defined by inner and outer cone angles and start and stop clock angles (see Figure 2.4.a).   

 

Figure 2.4.a. Lambertian distribution in a specified region of interest. 

When specifying a region of interest, the DLL will scale the intensity of the rays launched into the region 
while preserving the spatial and angular distribution as if a full 2π hemi-sphere of rays was launched. 

The source code for this DLL can be found in <data>\DLL\Sources (see section 5.1). 

3 USABILITY AND NAVIGATION 

3.1 IMPROVED GO TO SURFACE, OBJECT, OR OPERAND TOOL (ALL EDITIONS) 
Quickly find the right surface, object, or operand using enhanced search capabilities. 

The Go To tool has been improved for a faster and more efficient navigation of large sets of surfaces, 
objects, or operands. You can find and jump to a specific row in any editor even easier now. The tool lists 
all available comments in a pre-populated drop-down menu. When typing in a string of characters, you 
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can search through all comments using the Previous, Next, First, or Last buttons (see Figure 3.1.a). When 
typing in a number, you simply jump to the specified row. 

    

Figure 3.1.a. The Go to Operand tool in the Merit Function Editor with pre-populated comments (left) 
and the new buttons (right). 

This tool can be found in the toolbar of the following editors: Lens Data Editor, Merit Function Editor, 
Tolerance Data Editor, Non-Sequential Component Editor, Multi-Configuration Editor and Field Data 
Editor (see Figure 3.1.b). 

 

Figure 3.1.b. The Go to Surface tool can be accessed via the Lens Data Editor Toolbar. 

3.2 RIGHT-CLICK TO ADD AND REMOVE BOOKMARKS (ALL EDITIONS) 
Easily create a reference to an editor section you want to remember. 

You can improve the organization of large sets of editor rows by using bookmarks to navigate the editors 
faster.  

      

Figure 3.2.a. After adding a bookmark by right-clicking an editor row and selecting Edit bookmark (left), the 
Go to Surface tool shows all available bookmarks (right). 

To create, edit, or remove a bookmark, simply highlight and right-click the desired row in an editor and 
select Edit bookmark (see Figure 3.2.a). The Go To tool shows all available bookmarks and thus allows to 
jump to the desired section. 
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3.3 IMPROVED RESPONSE TIME IN THE EDITORS 
Delete and copy rows in shorter time. 

The performance of the editors when deleting as well as copying rows has been significantly improved. 
Editors with large sets of rows now demonstrate a considerably reduced lag time when those actions are 
carried out. This is particularly important for lens files with a lot of surfaces, objects, or operands. 

Rows can be copied or deleted by selecting them on the left side of the editor using the mouse cursor 
and then select Copy or Delete Surfaces, Operands, or Objects in the right-click menu (see Figure 3.3.a). 

 

Figure 3.3.a. Right-click menu showing the Delete Operands option in the Merit Function Editor. 

4 MANUFACTURABILITY 

4.1 COST ESTIMATOR UPDATES (ALL EDITIONS) 
Instantly get cost estimates for aspheric lenses. 

The Cost Estimator gives you immediate cost estimates for your design. You can determine the optimum 
balance of performance versus when adjusting tolerances. The cost impact and sensitivity for several 
optical component manufacturing tolerances can be evaluated. With the recent updates to the boundary 
conditions for cost estimates from Optimax, Even Asphere surfaces are now supported (see Figure 4.1.a). 
The accepted diameter range of parts with spherical and plano surfaces has been increased to 5-100 mm, 
while for aspheric surfaces it is 10-100 mm.  
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Figure 4.1.a. ISO Element Drawing of a plano-convex aspheric lens with successful cost estimation. 

The Cost Estimator can be found in two locations in OpticStudio. The standalone tool can be launched 
from the Production Tools section on the Tolerance tab or directly from within the ISO Element Drawing, 
located in the Manufacturing Drawings and Data section on the same tab (see Figure 4.1.b). 

 

Figure 4.1.b. Access the Cost Estimator and ISO Element Drawing from the Tolerance tab. 

For further details on how to use this tool to get real-time cost estimates, read this Knowledgebase article.  

4.2 EXPORT NON-SEQUENTIAL SURFACE DATA (PROFESSIONAL AND PREMIUM 

EDITIONS) 
Calculate and visualize the detailed shape of non-sequential objects to expedite the optical 
fabrication process. 

Sag data is an important part of the process of getting an optical design manufactured, as it describes the 
surface shape in a sampled grid of data which is typically used by manufacturers as part of the 
specification of a component. The sequential analysis Surface Sag provides the sag, or change in z-
position, of a surface from the local vertex as a function of x- and y-positions on the surface. Non-
sequential systems are more general than the mirrors and lenses commonly defined in sequential mode.  

OpticStudio 18.4 includes an example ZOS-API User Analysis which calculates the surface sag for non-
sequential component (NSC) objects (see Figure 4.2.a). This analysis traces an array of source rays to the 

http://customers.zemax.com/os/resources/learn/knowledgebase/how-to-get-real-time-lens-prototype-costs-in-optic
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face of a non-sequential object and calculates the intersection coordinates. The result of the calculation is 
either a graph or a text output that can easily be exported. 

 

Figure 4.2.a. Sag of a non-sequential surface object. 

The NSC Sag User Analysis is located in the ZOS-API.NET Applications section on the Programming tab, in 
the User Analyses menu (see Figure 4.2.b). 

 

Figure 4.2.b. Access the NSC Sag User Analysis from the Programming tab. 

More information on how to use this analysis can be found in this Knowledgebase article. 

5 PROGRAMMING 

5.1 SOURCE CODE FOR LAMBERTIAN_OVERFILL.DLL SOURCE OBJECT (PROFESSIONAL 

AND PREMIUM EDITIONS) 
Get started quickly on implementing your own source distribution.  

The Lambertian_Overfill.DLL source object can be used to launch a Lambertian distribution of rays towards 
a virtual circular aperture and overfill it. The source code for this DLL has been added to the installer (see 
Figure 5.1.a). You can use this code as a starting point for your own source distribution.  

http://customers.zemax.com/os/resources/learn/knowledgebase/nsc-sag-map-user-analsis
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Figure 5.1.a. The source code for Lambertian_Overfill.DLL. 

The source code can be found in the folder for Source DLLs, which is <data>\DLL\Sources. 

5.2 RAYTRACE.DLL FOR MATLAB (PROFESSIONAL AND PREMIUM EDITIONS) 
Speed up the analysis of ray trace results using the ZOS-API.  

Analyzing ray trace results with the ZOS-API in MATLAB is typically done using for- or while-loops. You 
can now speed up these time intensive loops in MATLAB by handing them off to a native compiled C# 
program. This C# DLL reads blocks of ray data into MATLAB all at once, rather than using MATLAB’s 
comparatively inefficient loops. The C# program then passes back the raw values after looping through all 
the results back to MATLAB for final processing. 

The DLL includes the following interfaces and inherited methods from the ZOSAPI.Tools.RayTrace 
namespace (see Figure 5.2.a): 

- IRayTraceDirectPolData (sequential) 
- IRayTraceDirectUnpolData (sequential) 
- IRayTraceNormPolData (sequential) 
- IRayTraceNormUnpolData (sequential) 
- IZRDReader (non-sequential) 
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Figure 5.2.a. The ZOS-API Syntax Help dialog box, open to Tools.RayTrace with all included interfaces 
highlighted. 

The Raytrace.DLL and example scripts demonstrating how to use it can be found in this Knowledgebase 
article. There are 3 basic examples and 3 advanced examples for sequential direct, sequential normalized, 
and non-sequential ZRD ray tracing. 

6 OTHER IMPROVEMENTS 
OpticStudio 18.4 includes the following improvements: 

Sequential tools and analyses 

• Image Simulation analysis - Image Simulation now ignores WAVE operands in the multi-
configuration editor when the RGB option is selected. 

• Elliptical Grating 1 surface - The ray tracing algorithm has been improved for the Elliptical 
Grating surface in sequential mode, allowing for better results at grazing incidence. 

• Set Vignetting tool - The ray sampling used in both the Set Vignetting calculation of the Field 
Data Editor and in the SVIG merit function operand for “Precision” inputs of 0 and 1 has been 
increased by a factor of 4. 

• Coordinate Return solve - The algorithm used by the Coordinate Return solve has been 
improved to work with systems in which inversion of the global coordinate rotation matrix was 
previously subject to numerical noise. 

• Black Box Lens - Surfaces inside of a Black Box Lens can now be scaled with the Scale Lens tool. 

Non-sequential tools and features 

• Non-sequential ray trace -  When rays are terminated at the edge of an object in non-sequential 
mode, they cannot be traced further when striking the exact edge of the object. These rays are 
now recorded as lost energy during the non-sequential ray trace. 

• Detector Color object - The decimal precision for text results shown on the Detector Color 
object has been increased to match the precision shown on all other detector types. 

• Convert To NSC tool - The algorithm used in the Convert To NSC tool has been updated to 
remove the generation of unnecessary operands in the multi-configuration editor that were 
previously being created in the non-sequential file during the conversion process. 

http://customers.zemax.com/os/resources/learn/knowledgebase/batch-processing-of-ray-trace-data-using-zos-api-i
http://customers.zemax.com/os/resources/learn/knowledgebase/batch-processing-of-ray-trace-data-using-zos-api-i
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• Convert To NSC tool - The algorithm used in the Convert To NSC tool now includes the Radius 
of Rotation when converting a toroidal surface from sequential to non-sequential mode. 

• NSC Shaded Model - Object highlighting in the NSC Shaded Model will now update correctly 
when inserting or deleting objects from the NSC editor and when the system update status is set 
to Update: All Windows or Update: Layout Windows. 

• Sphere object - The algorithm used to apply Grid GRIN data on spherical objects has been 
improved. The Grid GRIN Index Region no longer expands beyond the Sphere volume. 

• DLL Defined Scattering - The K-correlation surface scattering DLL now accounts for energy loss 
at non-normal angles of incidence. 

Programming 

• ZOS-API Syntax Help - Examples have been added to the ZOS-API Syntax Help documentation 
to illustrate how to modify Project Preferences via the API and how to use the 
ReadNextSegmentFull method for reading data from a ZRD file.  

• User Analysis - User Analyses created in ZOS-API can now switch the TheAnalysisData from 
MakeText() to Make2DLinePlot(). 

• User Analysis - User Analyses created in ZOS-API can now access the settings of a cloned 
window. 

• MultiConfigOperandType enum - Multi-configuration operands CHZN and MCSD are now 
included in the ZOS-API MultiConfigOperandType enumeration. 

• ZOS-API Syntax Help - Example #21 in the ZOS-API Syntax Help documentation has been 
updated to correspond with the latest version of the non-sequential Photoluminescence model. In 
addition, the Syntax Help has been updated to include information about ZOS-API example files 
#4 and #6. 

• CylinderFresnel enum - A typo in the ZOS-API, in which the enumeration (and corresponding 
interface) for the Cylinder Fresnel sequential surface were named "CylinderFrensel" (with the "n" 
and the "s" switched in Fresnel), has been corrected. 

Licensing 

• Network softkey license - The Sentinel LDK runtime version has been updated to version 7.63. 
The previous version included an issue where a checked-out (offline) license seat would be 
removed from a client computer when it was restarted. This affected client machines with 
OpticStudio 17 through 18.1 or those who installed Sentinel LDK runtime version 7.60. For more 
information, see the License Check Out section of the knowledgebase article How to 
Troubleshoot Softkey License Issues. 

 

7 BUG FIXES 
OpticStudio 18.4 includes the following fixes: 

Sequential tools and analyses 

• Hammer Optimization - An issue with the Hammer optimization algorithm has been corrected, 
which ensures that when optimization is terminated the resulting system is always the best system 
found to that point. 

• Global Optimization - An issue in which the Global Optimization algorithm would update the 
Field type for systems in which a DISC operand was included in the merit function editor has been 
fixed. 

http://customers.zemax.com/os/resources/learn/knowledgebase/how-to-troubleshoot-softkey-license-issues
http://customers.zemax.com/os/resources/learn/knowledgebase/how-to-troubleshoot-softkey-license-issues
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• Merit Function Editor - An issue in which incorrect results would be generated in the merit 
function editor when using the IMSF operand in an editor with multiple DMFS operands has been 
corrected. 

• Ray Aiming - An issue where Ray Aiming failed in systems with fields defined using Paraxial 
Image Height with a very small range of fields has been corrected.   

• Automatically Calculated Pupil Shifts - An issue with automatic calculation of the Pupil Shifts 
used in Ray Aiming for systems with very large Entrance Pupil Diameters (> 1000 lens units) has 
been corrected. 

• Coordinate Break - An issue with the calculation of surface thickness when a solve is used on the 
Thickness column in systems with Coordinate Breaks and dummy surfaces has been corrected. 

• Fiber Coupling - An issue with the Fiber Coupling calculation based on using the Huygens PSF 
for cases in which the source fiber was tilted or decentered has been corrected. 

• Fiber Coupling - An issue with the Fiber Coupling calculation using the Huygens integral for 
systems in which the Huygens PSF is calculated via a spherical phase reference has been 
corrected. 

• Pickup solves - An issue in which pickups solves were not being correctly generated by the Ghost 
Focus Generator tool in systems with Model glasses has been corrected. 

• Zernike Annular Sag surface - An issue in which coefficients of the Zernike Annular Sag surface 
were incorrectly being identified when constructing the surface sag has been corrected. 

• Geometric MTF analysis - An issue in which the Geometric MTF incorrectly indicated that the 
working F/# could not be calculated in systems where that was not true (i.e. for systems where the 
F/# could be calculated as indicated by other analyses and tools) has been corrected. 

• Thermal Pickup solve - An issue in which the thermal expansion of a lens was not being correctly 
calculated via the Thermal Pickup solve for surfaces whose material was set to Model has been 
corrected. 

• Image Simulation analysis - An issue with Image Simulation in which incorrect results could be 
generated when using the wavelength option “1+2+3” for systems in which the System 
Wavelengths were not defined in ascending order has been corrected. 

• Rectangular Array - An issue with calculation of merit function weights for the Angular, Contrast, 
and Spot options when using Rectangular Array for the pupil sampling has been corrected. 

Non-sequential tools and features 

• Photoluminescence - An issue with calculation of the down-converted energy in the 
Photoluminescence model for systems with energy units of Lumens has been corrected. 

• Birefringent objects - An issue with the intensity calculation for reflected rays in birefringent 
components modeled in non-sequential mode has been corrected. 

• Hologram Lens object - An issue with the Hologram Lens object in which incorrect results were 
generated when the object was used in reflection and had different materials on either side of the 
reflective face has been corrected. 

Programming 

• GetAvailableMacros method - The ZOS-API method GetAvailableMacros in ISolveZPLMacro, 
which worked before the release of OpticStudio 16.5 but was broken in that release, is once again 
working. 

• NSRA keyword - The ZPL keyword NSRA has been updated to use the sampling method 
(Random or Sobol) specified under the Sources tab of the Object Properties dialog box for each 
source. Previously this operand always used the Random method regardless of specification. 
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